
Lighting Your Model. 

There have been numerous posts in various forums on the subject of installing lighting in models. 

The majority of these are about simulating oil lamps on sailing ships, and the possibility of making 

the lights flicker. 

This article is an attempt to provide a range of options, using LEDs, from the simple to the not quite 

so simple! 

A separate article- Electrical supplies for models and modelling.is also available 

LEDs 
 

LEDs or Light Emitting Diodes are ideal for this task as they are very efficient (they don’t get hot), 

have very long life times, are small and very cheap. A basic LED does, however, have very different 

characteristics to a normal filament bulb so you need to understand this before connecting them. 

A normal filament bulb is basically a resistor. When you connect a supply to it, current flows through 

the filament which heats up. If you increase the supply voltage, more current flows and the filament 

gets hotter and the light gets brighter. In other words, the higher the voltage, the brighter the light. 

Not so an LED. The first difference is that, as the name implies, an LED is a diode. That means that 

electricity only goes through it in one direction. If you connect it the wrong way round, it won’ t do 

any damage to it, but it won’t light up either! 

The second difference is that an LED is a constant voltage device, typically around 2 volts. If you 

connect a supply to and gradually increase the voltage, at less than 2 volts it will do nothing at all. 

However, once you get above 2volts it will pass some current – as much as your power supply can 

supply - for a very short time! You may see it light briefly (very briefly) but you’ll need another LED! 

The reason for this is that the LED determines the voltage across it and power supply determines the 

voltage of the circuit. How much current flows depends on how much higher the supply voltage is 

than the LED voltage and how much resistance there is in the circuit. And that’s where the problem 

lies, the resistance in the circuit is next to nothing, so as soon as your power supply voltage gets 

above the 2 volts or so that the LED requires, a large current flows through the LED. 

Basic Circuit 
 

The way to limit the current flowing through an LED is to connect a suitable value resistor in series 

with the LED. 

You can buy LEDs with resistors or other control circuitry ‘built in’ but we are considering the basic 

LED for this application. These are available in various colours and either 3 or 5mm diameter. 3mm 

yellow LEDs are the ones to look for. These typically have a forward voltage of about 2.1 volts and a 

maximum current rating of about 20mA. (that’s 0.02 Amps). 

  

https://www.modelshipbuilder.com/how-to/electrical-supplies.pdf


Here’s how to connect an LED to a three cell battery: 

 

Note: The two leads of an LED are different lengths. The longer lead is the positive 

lead (the left hand one connected to the resistor in the picture above.) 

The first thing to note is that nothing here is critical. Depending on what type of cells you use in the 

battery, you can end up with a voltage anywhere between 3.6 volts (NiMH at 1.2 volts per cell) and 

4.8 volts (alkaline battery or fully charged cells). Let’s assume the nominal 1.5 volts per cell and say 

4.5 volts for the battery. 

Quite often, if you buy LEDs on line, you won’t find the voltage specified, but they’re all much the 

same. Let’s assume 2 volts. 

Now it’s decision time, how much current do you want to pass through the LED? You don’t want 

brilliant LEDs, oil lamps were a naked flame, so let’s aim for 10mA current through the LED. 

The calculation is simple There’s 4.5 Volt coming from the battery and 2 of those volts are dropped 

across the LED. That means that we need to lose the remaining 2.5 volts across the resistor. 

To find the value of the resistor, divide the voltage across it (2.5) by the current (10mA or 0.01 

Amps). That’s 250 ohms. 

(If you prefer, rather than working in amps and ohms, work in mA and Kilo ohms, the calculation 

then becomes 2.5/10 which is 0.25K ohms.) 

It’s just as well that the calculations aren’t critical because when you come to order your resistors, 

you’re unlikely to find the exact size you’ve calculated! That’s because they’re sold in ‘preferred’ 

sizes. (For the technical, the values go up in a geometric progression rather than an arithmetic 

progression). The nearest ‘preferred’ values are 220 ohms and 270 ohms. Either will do, but as we 

assumed a high battery voltage, we’re already on the safe side so I’d probably pick 220 ohms. 

Let’s re-run the calculation assuming you’re using a 5 volt DC power supply. 

The voltage across the resistor is now (5 - 2) volts. I can manage that without a calculator (3 volts) 

and dividing that by 10 (milliamps) gives 0.3 K ohms or 300 ohms. Again, you won’t find that value 

resistor, the options are 270 or 330. Either will do. 

  



Practical Connections 
 

You’re going to need more than one LED so what’s the best way of arranging this? 

There are two options: 

1. Run a positive and negative supply along the ship and spur off to each LED 

2. Run a negative lead along the ship and spur off to each LED but run a separate positive lead 

to each LED. 

Option 1 at first looks attractive, but gives rise to a couple of problems. 

The first of these is that the resistors have to be located in the positive spurs leading to the LED. This 

can, in some places, be a problem. 

 

The second problem is in actually making the ‘Tee’ connections themselves. The negative lead can 

be run as a bare copper wire. This allows simple connections anywhere along its length. 

 

It would be nice to do the same with the positive lead but, unless it’s kept away from the negative 

lead (e.g. at the other side of the ship), keeping the connections apart becomes difficult and this will 

probably need to be an insulated lead. In this case, installing LEDs progressively along the length of 

the ship shouldn’t be a problem, but going back and adding one part way along the route will be 

difficult. 

Option 2 requires more wiring, but can actually be much easier to do. The resistors no longer have to 

be near the LEDs. The method suggested is to mount the resistors together on a circuit board. 

  



The board to use is known as ‘strip board’ or ‘veroboard’ and looks like this: 

 

(This is view of the under-side of the board.) 

Offcuts and small sections are readily available on ebay and can easily be cut to size. 

The holes are 0.1 inches apart and the copper tracks, which are laid on an insulating base, can be cut 

where required by using a drill bit as a countersink over any of the holes. Components and 

connecting leads are pushed through the holes from the top and soldered to the tracks on the 

under-side. 

I copied the following example from a picture on the internet to show the principle but then spotted 

an example of what to avoid. If you look at the bottom hole in the column of four, the copper strip 

isn’t completely cut. This can easily be rectified by a couple more turns with a drill bit or using a knife 

point to scrape off the copper above the hole, but is something to look out for. 

 

 

Here are front and back views of two ways of laying out and mounting the resistors on veroboard: 

 

  



          

Wiring with the resistors fitted on a circuit board is much simpler: 

 

You also have the option of making more than one board and installing one near the bow and 

another near the stern. 

Note: You can buy sections of ribbon cable in various widths and lengths. Using this together with a 

bare copper wire for the negative lead is a neat way of wiring the lights. The individual conductors of 

the ribbon can be peeled back one by one to connect to the LEDs. 

 

  



Flickering Lights 

 

Lighting on pre 20th century sailing ships would have been provided by oil lamps. There appears to 

be a general assumption that this means that the lights would have flickered. In practice, an oil lamp 

only flickers in a draught or if it’s physically disturbed. So, if you wish to make your lights flicker, 

most viewers will be happy with the effect and you can tell the rest that the ship’s in rough water. 

The hardware. 

Making the LEDs flicker is relatively simple, but does require taking some people out of their comfort 

zone and introducing them to micro computing! 

Before you decide this is a step too far, let me say that it only requires one additional item to those 

described above (and some pins to connect to it). 

This is the item in question: 

 

It’s an Arduino Uno and the one pictured was priced at £3.14, less than $5, at the time of writing. 

The blue usb lead is only required for the initial setup. The board is 68mm long and 53mm wide so 

finding room for it shouldn’t be too difficult. This particular seller includes a usb lead and a strip of 

the connecting pins that fit the Arduino’s sockets. 

You’ll see lots of Arduinos at significantly higher prices than this, most of them looking slightly 

different. These have a large integrated circuit (the microprocessor) mounted in a socket on the 

board. The one pictured has a ‘surface mount’ microprocessor that can’t be removed. Don’t worry, 

it’s electrically the same and all the versions will do what we need to do. 

The Arduino has 18 pins that can be configured as either inputs or outputs so, using them all as 

outputs, you can connect 18 LEDs that will flicker independently. 

If you want more than 18 LEDs, as each output supplies 5 volts, it is possible to connect 2 LEDs in 

series to each output. Those two will, of course, flicker together so it would be best to have them 

physically separated - or you could simply fit another Arduino at the other end of the ship. 

  



Programming. 

Before we go any further, let’s explain how to program the Arduino. 

For this you need a PC (or to know a friend with a PC). It’s not something you can do with a tablet or 

smartphone. 

The first thing you need is a programme called the Arduino IDE. It can be downloaded from this 

page. If you have Windows 8.1 or 10, choose the ‘Windows App’. 

You now need a programme to install on your Arduino. You can download the programme code 

from here. The programme is in a zip file called flicker.zip. If you open the zip file, you will find a 

folder called flicker. Copy the folder to your desktop or anywhere else you prefer. We’re now ready 

to start. 

The order in which you do things now makes a difference. Plug in the Arduino. Now run the Arduino 

IDE programme. The programme will open with a basic ‘Sketch’ asking you to enter some code. 

Just as a check, click the ‘Tools’ tab and move your mouse down to the line that says ‘Port’. There 

should be more than one option with the highest number option already selected. 

If you open the programme before plugging in the Arduino, the correct port won’t be available; 

you’ll probably only see ‘com 1’. However you can still plug in the Arduino and then select the new 

port that appears. 

Now select the ‘File’ tab, click ‘Open’ and navigate to the ‘flicker’ folder. Open the folder and select 

and open the ‘flicker.ino’ file. That will open a new window with programme code in it. 

Now click the ‘Sketch’ tab and select ‘Upload’. You’ll see a green progress bar whilst the programme 

compiles the code after which it will upload it to the board. That’s it, job done! 

While the Arduino is connected to your PC via the usb cable, it will be powered from the PC, you 

don’t need a separate power supply yet 

The Arduino board actually has four small LEDs on it. Two of these (usually yellow) show when data 

is passing between the board and the PC so they’ll flash briefly when you programme the board but 

then go out. That leaves two which should now be lit. I’ve seen these in different places and 

different colours but the ones I have at the moment are red and green. The red one shows that the 

board is powered so will be lit continuously. The other is connected to output 13 for general 

indication. That means it’s connected just the same as your lights will be, so if you look carefully, it 

should now be flickering! 

If you’ve got this far, from here on the connections are much the same as for non-flickering LEDs. 

Note: If you’re unsure about your ability to carry out the programming, you can experiment now, 

without buying any parts. You can install the Arduino software and download the code by following 

the links above. If you can success fully open the code with the Arduino software, you’re one click 

away from putting the code on an Arduino. 

  

https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Main/Software
http://modelshipbuilder.com/how-to/flicker.zip


Flickering Light Connections. 

 
As before, it’s best to mount the resistors on veroboard. There are four separate sockets on the 

Arduino and for some reason the spacing of these doesn’t quite correspond to a regular 0.1 inch grid 

- so you can’t fit a single piece of veroboard to the Arduino that has all the required outputs on it. 

You can, however fit two separate boards. 

 

 

 

If you cut off a strip of pins and position them on the component side of the board with the longer 

pins through the holes you can then then turn over the board so the copper side is uppermost with 

the long pins sticking up through the holes. Rest the pins on a hard surface and press down on the 

board adjacent to the pins. The pins will move up through the black plastic until the short ends are 

flush with it. It’s best to do this with the pins at the other end of the board as well before soldering. 

If you have both sets of pins in position, the pins will sit square to the board while you solder them 

to the tracks. 

Check that the bottom board fits in the Arduino. The right hand plug fits at the top end of right hand 

socket. The lower two holes in that socket (numbered 0 & 1) aren’t used. 

This board is for a different project, but the pictures show how it fits: 

                  



Now try the other board above it. You’ll need to trim the lower edge of this board, particularly at the 

right hand side, to get it to fit. 

 

Once you’ve done that you can cut the tracks and solder the resistors on the boards. (Note the 

section removed from the bottom track - that’s to avoid the set of pins you can see sticking up from 

the Arduino at this point.) 

You can solder your wires to the board later as the boards can be unplugged as required. 

The Arduino can be run from a regulated 5 volt supply but by far the best option is to run it from a 

12 volt supply. You can connect this to the bottom board, as shown, or simply plug it into the 

Arduino’s power socket. 

And finally, the following picture shows an example of how the LEDs are connected. 

(If you require more negative leads, the bottom left hand track on the top board is also a ‘ground’ 

connection.) 

 

  



The lights I fitted in Vanguard were installed some time ago and use the same microprocessor as the 

Arduino, but not an Arduino itself so I don’t have an Arduino fitted with the two circuit boards 

described above to demonstrate, 

However I have connected the Arduino to some LEDs so you can watch a video of the Arduino and 

LEDs in operation. 

For the technical 
 

The resistors recommended (and used in the video) are 270 ohms. These limit the current to about 

10mA. The Arduino can supply more than this, the recommended maximum is 20ma but the 

absolute maximum is 40mA for each output. 

There is, however, another restriction; the total load should not exceed 200mA. There are 18 

outputs so 10mA per output is as about as high as you should go. 

Although the Arduino’s nominal output voltage is 5 volts, the actual voltage is slightly less than this. 

At 10mA load it’s about 4.6 Volts. The voltage across an LED does vary slightly with current and the 

ones I’m using are taking about 1.9 volts on average. If you want more lights, connecting 2 LEDs in 

series actually has surprisingly little effect on the brightness, but you can fit lower value resistors to 

restore the brightness. You now only need to drop 0.8 volts, so that equates to 80 ohm resistors. The 

nearest ‘preferred’ value is 82 ohms. 

The wattage of the resistors isn’t an issue. The amount of power they need to dissipate is the current 

through them times the voltage across them. That’s 0.01 x 2.7 or 0.027 watts (27 milli-watts.). The 

smallest ones you’re likely to find are1/8th watt, which is near enough 5 times more than you need!  
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